REN ESAS Application Note

RZ/T2H
Program Writing Guide

Introduction

This document describes how to build the program that runs on the RZ/T2H Evaluation Board and how to
write the program to the serial flash memory.

This document presents a guide to writing for the following sample program.

r01an7333XX0100-rzt2h-motor-control.zip
Jworkspace/RZT2H_INVBLVY_SPM_ENCD_FOC_E2S V100 (e? studio)
Jworkspace/RZT2H_INVBLV_SPM_ENCD_FOC_EWARM_V100 (IAR Embedded Workbench for Arm)

Target Device
RZ/T2H (R9A09G077M44GBG)
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RZ/T2H Program Writing Guide

1. Overview

1.1 Hardware Configuration
Figure 1-1 shows the hardware connection configuration and Table 1-1 lists the equipment to be connected.

USB cable Connection cable Inverter Board
for the evaluation board (RTKOEMO000B15010BJ)

* (9-axes) *
= l’
RZ/T2H Motion Control Utility PC RZ/T2H Evaluation Board Bus Board Motor/Encoder
(RTKORZT2HOCW1000BJ) (RTKOEM0000Z03000BJ) (TAMAGAWA SEIKI)

Figure 1-1 Hardware Configuration (Connection Configuration)

Table 1-1 Hardware Configuration (Connection Equipment)

Equipment Model name
RZ/T2H Evaluation Board RTKORZT2HOCW1000BJ
MPU R9A09G077M44GBG
729-pin FCBGA, RAM 2[MB]
On-board memory OctaFlash: 64[MB]
Operating frequency Cortex-R52 CPUOQ: 1000[MHZz]
Cortex-R52 CPU1 and Cortex-A55 are unused.
Operating voltage DC 15[V]/3[A], 15[V1/3[A]
Operating mode xSPI0 boot mode (x1 boot serial flash)
Bus Board RTKOEMO0000Z03000BJ
Inverter Board RTKOEMO0000B15010BJ
| Operating voltage DC 24[V]
Motor TSM3101N2001E020
/Encoder /TS5669N124 (FA-CODER®)
(manufactured by TAMAGAWA SEIKI)
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1.2 Software Configuration
Table 1-2 shows the software development environment and Table 1-3 shows the tool to support

development.

Table 1-2 Software Configuration (Development Environment)

Integrated Development

) .

Environment (IDE) e studio IAR Embedded Workbench for Arm
. 9.60.2 + patch

IDE version 2024-10 (EWARM patch for RZ/T2H Rev.1.0)
. FSP Smart Configurator

FSP version 2.2.0 2024-10

Toolchain version GNU Arm Embedded i
ih versi 12.2.1.arm-12-24

In Circuit Emulator (ICE) J-Link OB IAR I-jet

Table 1-3 Software Configuration (Tool to Support Development)

Tool name

Tool version

RZ/T2H Motion Control Utility

1.0.0.0
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2. How to Build and Write the Program

2.1 e?studio

2.1.1 Unzip the Sample Program
Unzip the following sample program to any folder.

The path should be only half-width alphanumeric characters and underscores.

r01an7333XX0100-rzt2h-motor-control.zip
Jworkspace/RZT2H_INVBLV_SPM_ENCD_FOC_E2S V100

2.1.2 Launch the IDE
Launch e? studio from the Windows start menu.

Specify the workspace directory (./workspace) and click the [Launch] button.

2.1.3 Import Existing Project
Select [Import] from the [File] menu to open the Import dialog box.

Select [Existing Projects into Workspace] from [General] and click the [Next] button.

Select the root directory (project folder) from the [Browse] button and click the [Finish] button.

2.1.4 Build the Project
Select [Build All] from the [Project] menu to build the project.

If the build is successful, the message "Build Finished" will be displayed in the [Console].

2.1.5 Download (Debugging)
Click the ™ ™ button to start debugging.
This operation writes the program to the serial flash memory.

If the download is complete, the message "Finished download" will be displayed in the [Console].

Click the ™ button to terminate debugging.
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2.2 |AR Embedded Workbench for Arm

2.2.1 Unzip the Sample Program
Unzip the following sample program to any folder.

The path should be only half-width alphanumeric characters and underscores.

r01an7333XX0100-rzt2h-motor-control.zip
Jworkspace/RZT2H_INVBLV_SPM_ENCD_FOC_EWARM_V100

2.2.2 Launch the IDE
Double-click the workspace file (*.eww) in the project folder to launch IAR Embedded Workbench for Arm.

2.2.3 Build the Project
Select [Rebuild All] from the [Project] menu to build the project.

If the build is successful, the message "Build succeeded" will be displayed in the [Build] window.

2.2.4 Download

Select the [Download] > [Download active application] from the [Project] menu to write the program to the
serial flash memory.
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3. Operation Confirmation

Remove the ICE from RZ/T2H Evaluation Board and start up standalone.

Operate the RZ/T2H Motion Control Utility and check that the motor rotates.

For details, see "RZ/T2H Startup Manual (RZ/T2H Motion Control Utility) (RO1AN7334)".

4. Reference Documents

e RZ/T2H Startup Manual (RZ/T2H Motion Control Utility) (RO1AN7334)
e RZ/T2H Vector Control for Permanent Magnetic Synchronous Motor with Encoder (9-axes)
- Absolute Encoder (RO1AN7333)

e ¢?studio Integrated Development Environment User's Manual: Getting Started Guide RZ Family
(R20UT4535)
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General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit
Products
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Pronhibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.

O Arm and Cortex are registered trademarks of Arm Limited (or its subsidiaries) in the EU and other
countries. All rights reserved.

O IAR Embedded Workbench for Arm is a registered trademark owned by IAR Systems AB.

O J-Link is a trademark of SEGGER Microcontroller GmbH & Co. KG.

O FA-CODER is a registered trademark of TAMAGAWA SEIKI Co., Ltd.

O Additionally all product names and service names in this document are a trademark or a registered
trademark which belongs to the respective owners.
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(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’'s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2024 Renesas Electronics Corporation. All rights reserved.
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